Physics 246 College Physics Lab II            Spring 2010
Instructor: Anna Wyczalkowska
Prerequisite: PHYS 244, Corequisite: PHYS245
Web Page: www.physics.gmu.edu/~jlieb/phys246
Course location (lab room): Room 228 Science & Technology I
Office: room 327, ST1
Phone: 993-4166
E-mail: awyczalk@gmu.edu
Office Hours: Wednesday: 4:30 pm - 5:30 pm
                                    Thursday: 10:30 am - 11:30 am

Dates Performed   Experiment

Jan 19 - 22  Introduction
Jan 26 - Jan 29  Electric Field Mapping  (ma)
Feb 2 - 5      The Capacitor
Feb 9 - 12     DC Circuits, Ohm’s Law and Multimeters
Feb 16 - 19    RC Decay (Discovery)
February 19 is the last day to drop without academic penalty.
Feb 23 – Feb 26  Power in DC and AC Circuits  (ma)
Mar 2 – 5       AC Circuits and Induction  (ma)
Mar 8 - 14     No Lab – Spring Break
Mar 16 - 19    Thin Lenses (Discovery)
Mar 23- 26     Reflection and Refraction of Light  (ma)
Mar 30 - Apr 2  To be announced / snow makeup day  (ma)
Apr 6 - 9      The Spectrometer and the Atomic Spectra of Hydrogen  (ma)
Apr 13 -16     Photoelectric Effect (Discovery)
Apr 20 - 23    Gamma Ray Energy and Absorption
Apr 27 - 30    Lab test

Lab write-ups must be downloaded from the course website before each class. Students will not be permitted to use the lab computers or printers for this purpose. See course web page (above) for link.

Grade Determination

PHYS 246 instructors met recently and decided allow a limited number of collaborative formal lab reports this semester. Instructors will identify those experiments where some or all members of a group may submit a common report with multiple authors (ma). You may still decide to submit an individual report for each experiment and receive an individual grade. You must decide if you are going to work individually immediately after the performance of the experiment and notify the other members of the group.

There are 11 laboratories scheduled and you are expected to perform 10 of these experiments. Eight of the experiments require a formal lab report, and the three experiments designated as discovery labs do not. You are expected to write 7 formal lab reports and participate in three experiments designated as discovery laboratories. If you turn in all eight of the lab reports, the lowest score will be dropped in computing your numerical grade (see formula below). In addition, there will be a pre-lab quiz that you will be expected to take on the Blackboard system before coming to lab. A student who receives a minimum score of 80% on all of the quizzes will be allowed to submit one fewer formal lab report (6 in all).

If you have not written at least 6 formal lab reports you will not pass the course (under certain circumstances a formal report can be written on a discovery lab as detailed below). The numeric grade will be calculated according to the following formula:

\[ \text{Numeric Grade} = [0.78 \times \text{Report Average} \times (N/10)] + (0.22 \times \text{TEST} ) + (\text{Discovery Scores}) \]
• **Report Average** = average of best 7 out of 8 formal lab report grades. (If a score of 80% on the pre-lab quizzes is achieved, the report average will be average of best 6 out of 8 formal lab report grades.) A student must write at least 6 formal lab reports to pass the course.

• \( N \) = number of laboratories completed (including discovery labs) but \( N \) cannot exceed 10. For example if a student only completed 8 of the 10, then that student would get \( 0.78 \times \text{Report Average} \times 0.80 \) plus the other two terms in the above equation and so would have their grade dropped by about 16 points out of 100 or about 1.5 letter grades compared with what they would have gotten if they had completed 10 labs. If they would have otherwise received at B+, for example, the lack of 2 labs would have lowered their grade to about a C. It should be noted that achieving a score of 80% on the pre-lab quizzes lowers the number of formal lab reports that must be written but does not affect the number of labs that must be performed \( (N=10) \). If you attend a lab but decide not to write it up, you should submit the signed data sheet as proof that you attended the lab.

• \( TEST = \) test grade percent

Discovery scores are assigned to the three discovery labs as follows:

- Outstanding: +1/2
- Satisfactory: 0
- Unsatisfactory: -1/2

The inclusion of the three discovery experiments which are noted on the schedule is designed to reduce the number of formal lab reports required while at the same time allowing students some experience in exercising their creativity in lab design. The above formula is designed to make the three discovery experiments have little impact on the student’s individual course grade for those who perform them satisfactorily.

The laboratories designated as discovery will be conducted as follows:

- Very short lecture.
- Instructor will only offer advice on technical matters.
- Instructor will ask questions of each group as the experiment progresses.
- Each group will submit a collection of data tables, graphs and a consensus conclusion at the end of the period.
- Individual students may also submit supplemental conclusions at the start of the next period and should do so if they disagree with the group conclusion.
- Groups that simply follow the lab manual during discovery labs are unlikely to receive an outstanding discovery score unless their experimental work is exceptional.
- Groups who work out their own techniques are more likely to receive an outstanding discovery score.
- The discovery scores awarded will be based on observations made by the instructor during the experiment, as well as, the data and graphs submitted and the group and individual conclusions.
- No formal report is required.
- If granted permission, a student who has missed several laboratory sessions may write a formal report on a discovery experiment in order to meet the minimum required number of formal reports. However for a good grade students must attend all but one of the experiments in the semester, and be prepared to be tested on all of the experiments.

About half of the test will cover treatment of uncertainties and the other half will cover questions about particular experiments. There may also be a short exercise or written questions about working with Excel or DataStudio.

**Goals for the Course:**

1. To enhance material covered in the main course by exposing students to the actual testing of the theories and equations discussed in lecture.

2. To teach students the basic techniques of computerized data acquisition and analysis.

3. To help students become more experienced in the written presentation of scientific data.

4. To give students a good understanding of experimental uncertainty and how it propagates through calculations.
General Information:
Experiments will be performed as shown on the lab syllabus but it may be necessary to modify the schedule. All labs will include an introductory lecture followed by completion of the laboratory assignment. The introductory lecture reviews concepts covered in Physics 245 relevant to the experiment, the specifics of equipment used, and the required data analysis. Students will not leave the lab room other than to go to the rest room without permission from the instructor. Before you leave the lab, you must request that the instructor review your data and sign it. Signed raw data sheets are required to be attached to reports when they are submitted.

All labs are due at the start of the next lab session after they are performed unless you are told otherwise by the instructor. Any late labs will be penalized (see lab reports). Please contact the instructor before the lab date if you know you will not be able to attend a session. Since this lab is performed many times during the week, you may be able to attend another session. This is only in extreme cases and subject to prior approval of both your instructor and the instructor who teaches the lab session you wish to attend. Do not show up to a lab session you are not assigned to without prior approval.

If special instruction is needed or questions arise about a lab, it is the student's responsibility to seek help from the instructor before the due date. Your instructor will announce office hours and may be available during other times by appointment.

Lab Groups:
Students will usually work in groups consisting of 3 students. All members of a group should be involved in conducting each lab experiment. Computers will be used for data acquisition and analysis in most experiments. Students should take turns working on the computer so that everyone gains the same experience working with Excel and the data acquisition system.

Lab Reports:
All students are required to submit a report for each experiment except the discovery labs. For labs that are not collaborative, this report must be an individual effort that reflects the student’s understanding of the experiment. Plagiarism is a violation of the honor code. Since students will work together, it is important to understand what permissible group work is and what must be done individually. In taking data, each student may perform a different role but everyone must participate in performing each part of the experiment. You may not report on parts of an experiment that you did not actively participate in. Usually one person will enter data into the computer and all students may use computer calculations and graphs done in lab.

Reports will be turned in to the instructor at the start of the next scheduled lab session. Reports not handed in at that time will be late and will be penalized 10%. Students are cautioned that you will not be permitted to print out a final copy of your lab report on the day it is due in the lab. All reports should already be printed and stapled when you walk in the door. Late lab reports will have 10% per week deducted from the grade. On very rare occasions, students with a good excuse may be permitted to turn in late work without penalty as long as they obtain the lab instructor’s permission prior to the due date. Normally this permission will only be granted once. The best way to request such permission is by email.

Pre-Lab Quizzes
Students are encouraged to read the lab handout and take a short quiz using the blackboard system before coming to lab. The scores on the quizzes will be averaged such that the two lowest grades are dropped. Students who achieve a score of 80% (this grade may be adjusted) will have their report average based on the best 6 lab reports with the other two dropped. It is important to note that this does not change the fact that a total of ten labs must be performed and the test could have questions on any lab.

Academic Integrity
GMU is an Honor Code university; please see the University Catalog for a full description of the code and the honor committee process. The principle of academic integrity is taken very seriously and violations are treated gravely. What does academic integrity mean in this course? Essentially this: when you are responsible for a task, you will perform that task. When you rely on someone else’s work in an aspect of the performance of that task, you will give full credit in the proper, accepted form.

For single-author reports, work that must be done individually includes the introduction, conclusion, uncertainty calculations and discussion of uncertainties. Students may discuss these sections with their lab
partners but the work must be done individually and copying of anything is strictly forbidden. In the case of an approved multiple-author report, collaboration is expected and all named authors must contribute. Any two reports which have identical sentences or have paragraphs with identical structure will be considered to be plagiarized.

Students may collaborate on the pre-lab quizzes but each individual student must submit the answers to their own quiz.

**Pre-Lab Lecture**
There is an introductory lecture at the beginning of each lab. It is expected that all students arrive on time and not miss any portion of this lecture. After the lecture, students work in their groups and conduct the experiment scheduled for that day. Students are encouraged to finish most of their calculations and uncertainty analysis in the lab. All students are required to have the instructor initial their data sheet before leaving the lab for the day. Since the introductory lecture is a necessary part of the lab session, students who arrive more than 15 minutes late or are consistently late will be penalized 5%. Students who miss too much of the lecture will not be permitted to do the experiment.

Computers may not be used for any purpose until the lecture is over. At no time may they be used for reading e-mail or web surfing. After lab, you may e-mail your results to your account or save them on a memory stick.

**GMU e-mail Accounts**
Students must activate their GMU email accounts to receive important University information, including messages related to this class.

**Office of Disability Services**
If you are a student with a disability and you need academic accommodations, please see me and contact the Office of Disability Services (ODS) at 993-2474. All academic accommodations must be arranged through the ODS. http://ods.gmu.edu

**Other Useful Campus Resources:**
WRITING CENTER: A114 Robinson Hall; (703) 993-1200; http://writingcenter.gmu.edu
COUNSELING AND PSYCHOLOGICAL SERVICES (CAPS): (703) 993-2380; http://caps.gmu.edu

Lab Report Format: Each member of a group must submit a typed (i.e. computer print out) laboratory report in his or her own words. Sample calculations may be done by hand. Please write on only one side of the page. Please don’t use any fancy binders and please staple the report in the upper left hand corner. The basic format of a report is as follows:

1. **Title page** includes:
   1. Name (upper right corner) (List all names if it is a collaborative report.)
   2. Experiment title and number (upper right corner)
   3. Section (give day of week and meeting time-upper right corner)
   4. Course Name (lower part of page)
   5. Lab partner's name (lower part of page)
   6. Date report was submitted (lower part of page)
   7. Instructor’s name (lower part of page)
   8. Word count (lower part of page)

2. **Introduction**
   State the purpose of the experiment and briefly describe the procedure used to conduct this experiment. Include a rough sketch of the setup. The introduction should include important equations and define symbols and units.

3. **Results and Discussion**
   Present all data collected in the experiment including graphs and spreadsheets. Explain the sources of uncertainties in your experiment and your estimate of the size of each uncertainty. Discuss any significant problems you encountered and how you resolved these problems. You should use your data, graphs and calculations to support your conclusion about the results obtained in the experiment. Discuss each graph in detail: tell what was expected and why it was expected (a reference to a theoretical equation
may help in explaining what “should” have happened) and what was observed. Number your tables and graphs in a consistent manner so that you may refer to them more easily in your conclusion.

4. Conclusion

Summarize the results and tell whether there was agreement between theory and experiment. The agreement or disagreement between the experimental and the accepted value of a quantity should be expressed as a multiple of sigma. If possible you should suggest ways of improving the experiment.

*NOTE: It is generally better to put your detailed analysis of the results with the graphs in the results and discussion section and let the Conclusion section summarize everything. Do NOT include the same information in each section—it should appear only ONCE in the report.

5. Sample Calculation with uncertainty propagation.

Include a sample of each type of calculation performed in the lab including propagation of uncertainties with sufficient details to enable the grader to evaluate your work. Sample calculations should be done by hand. The sample problems in the uncertainty part of the lab manual are a good guide to the format for uncertainty calculations.

Some Tips for Lab Reports

In writing your report your goal should be to cover everything that is required in as few words as possible. You are asked to include a word count on the front page and your instructor may impose a maximum word count for each report. Some students include “extras” in hopes of enhancing their grade but this is usually a waste of time. Examples of extra material that will not result in a better grade are details of the life of the scientist that did the work, derivations of the equations, history of the development of the theory, applications of the technology, discussions of how much you enjoyed or didn’t enjoy doing the experiment, describing how hard it was to make the measurements or how you initially made a mistake and wasted time.

You should discuss the sources of major contributors to the uncertainty of measurements but don’t simply give a laundry list of possible uncertainties with no indication of the magnitude of each contribution to the overall uncertainty.

1. Your report should be aimed at a reader who knows physics but who was not in the laboratory on the day you did the experiment. So you should provide sufficient information for such a knowledgeable reader to interpret you work.

2. In Microsoft Word and Excel it is very easy to insert symbols such as ±, θ, and σ. Use the pull down menu ‘Insert > Symbol’.

3. In Microsoft Word you can make superscripts and subscripts (x² or x₂) using the pull down ‘format>font’ or you can add icons to the toolbars for these operations.

4. To add a full equation to your report use the pull down ‘Insert> Object> Microsoft Equation 3.0’.

5. Assign a number, roman numeral or letter to each Table, Figure, or Graph and use this to reference them (i.e. “see Table II” or “refer to Graph C”).

6. Always round numbers to an appropriate number of significant figures.

7. A well designed table provides an excellent way to present the results of an experimental measurement. The following table shows fictional data for a measurement of the acceleration due to gravity using a pendulum where the length of the pendulum and the mass of the pendulum bob has been varied and g is calculated from the formula \( g = 4\pi^2 \frac{L}{T^2} \). \( T \) is the period of the pendulum (the time for one full swing back and forth) and \( T \) is measured. Since the mass of the pendulum bob does not enter the equation, changing the mass should have no effect.
<table>
<thead>
<tr>
<th>Length (m)</th>
<th>Mass (kg)</th>
<th>Period (s)</th>
<th>$g_{\text{exp}}$ (m / s²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.50 ± 0.02</td>
<td>0.25 ± 0.01</td>
<td>1.43 ± 0.02</td>
<td>9.7 ± 0.5</td>
</tr>
<tr>
<td>0.50 ± 0.02</td>
<td>0.50 ± 0.01</td>
<td>1.42 ± 0.02</td>
<td>9.8 ± 0.5</td>
</tr>
<tr>
<td>0.50 ± 0.02</td>
<td>0.75 ± 0.01</td>
<td>1.41 ± 0.02</td>
<td>9.9 ± 0.5</td>
</tr>
<tr>
<td>0.50 ± 0.02</td>
<td>0.75 ± 0.01</td>
<td>1.40 ± 0.02</td>
<td>10.1 ± 0.5</td>
</tr>
<tr>
<td>0.75 ± 0.02</td>
<td>0.75 ± 0.01</td>
<td>1.75 ± 0.03</td>
<td>9.7 ± 0.4</td>
</tr>
<tr>
<td>1.00 ± 0.02</td>
<td>0.75 ± 0.01</td>
<td>2.01 ± 0.04</td>
<td>9.8 ± 0.4</td>
</tr>
</tbody>
</table>

Notice how the organization of the table allows a critical evaluation of the data. For example, the first three rows show data in which the mass is systematically increased and this makes it easier to see that $g_{\text{exp}}$ also appears to increase. A careful consideration of the size of the uncertainties suggests that this increase is probably not real but it is a question that should be examined in the discussion. Although the theory predicts that there should be no dependence on mass, it is not unreasonable to think that air resistance may have less of an effect on a heavier mass. It should be noted that the uncertainty in each measurement is included in the table as well as the appropriate units.

8. In Microsoft Word, if you wish to generate a new table within the results section of your report, first make sure that you do not already have the information on a printout that you made during lab. (If you plan to replace the lab print out, that is fine—the goal is not to include redundant information.) Then, go to ‘Table > Insert > Table’ and specify the dimensions of the table. After you have initially set the number of columns and rows, the width and height of the table may be adjusted in the document using the cursor.

9. If you forget to put some information on a table or graph, no credit will be lost if you write it in by hand.

10. When printing in lab, please set all graphs to have a white background in order to save toner.

11. On discovery labs, it is important to remember that plotting data is usually the best way to understand the data, to check it for consistency, to analyze it, to present the data to the reader, and to draw conclusions from it. One must make decisions as to exactly what to plot, what type of scales to use (log, semi-log, linear), and so on, so as to best accomplish the above ends.